Clay Tablet Connector for Oracle WebCenter Sites

User Guide

Version 1.1

November 3, 2015
# Contents

1 Welcome to the Clay Tablet Connector for Oracle WebCenter Sites ............................................................. 5
   1.1 The Translation Lifecycle .................................................................................................................. 5
   1.2 How the Connector Helps You Manage Your Translation Lifecycle ............................................... 5
   1.3 Using this Guide ............................................................................................................................. 6
   1.4 How to Contact Clay Tablet Support ............................................................................................... 8

2 Getting Started with the Clay Tablet Connector for Oracle WebCenter Sites .............................................. 9
   2.1 Key Features .................................................................................................................................. 9
       2.1.1 Managing Translations with Workflow .................................................................................. 9
       2.1.2 Multiple Ways to Collect Assets for Translation ................................................................. 10
       2.1.3 Multiple Ways to Manage Collected Assets ....................................................................... 10
       2.1.4 Optimizing Translation ........................................................................................................ 10
       2.1.5 Selecting a Translation Provider ........................................................................................... 11
   2.2 The Connector at a Glance ............................................................................................................. 11
   2.3 How to Manage Translations with the Connector .......................................................................... 13

3 Collecting Assets for Translation ............................................................................................................... 15
   3.1 Collecting One Asset for Translation ............................................................................................ 15
   3.2 Collecting Multiple Assets for Translation ................................................................................... 21
   3.3 Filtering Assets in a List ................................................................................................................. 27

4 Adding Assets to Translation Jobs ............................................................................................................ 30
   4.1 Adding Assets in the Translation Queue to Jobs ........................................................................... 30
   4.2 Modifying a Job before Sending It Out for Translation ................................................................ 36
   4.3 Copying Assets Between Jobs ....................................................................................................... 40

5 Sending Out Jobs for Translation .............................................................................................................. 42

6 Monitoring the Translation Status of Assets and Jobs ................................................................................ 44
   6.1 Translation Statuses ....................................................................................................................... 44
   6.2 Monitoring All Translation Jobs ................................................................................................... 45
   6.3 Monitoring Assets in a Single Job .................................................................................................. 48
   6.4 Checking an Asset's Translation Status ........................................................................................ 51

7 Post-Translation Tasks .............................................................................................................................. 54
   7.1 Approving Translated Assets ......................................................................................................... 54
1 Welcome to the Clay Tablet Connector for Oracle WebCenter Sites

Welcome to the Clay Tablet Connector for Oracle WebCenter Sites ("Connector"). The Connector enables you to automate sending and retrieving assets from Oracle WebCenter Sites, which dramatically reduces the effort required to create, maintain, and publish Web content in multiple languages.

1.1 The Translation Lifecycle

The translation lifecycle is the broad process of selecting content, sending it out for translation, and then receiving the translated content back from translation.

This set of steps usually fits inside a larger, more general process called the content lifecycle, which is the process of creating, reviewing, editing, approving, and publishing content.

When you consider the translation lifecycle and the content lifecycle together, you have the global content value chain, which is the strategy for managing multilingual content.

The content lifecycle and the translation lifecycle are impacted by the workflow steps you implement in Oracle WebCenter Sites to manage multilingual content.

Remember that localizing content is a subset of steps in the broader content lifecycle. This will improve your focus on key localization considerations, improve processes, and keep all content stakeholders included. Together, this results in better content management.

1.2 How the Connector Helps You Manage Your Translation Lifecycle

The Clay Tablet Connector for Oracle WebCenter Sites ("Connector") is a plug-in module for Oracle WebCenter Sites. It provides a range of features and user interface enhancements in Oracle WebCenter Sites that enable you to select, send, monitor, and retrieve content for translation into any language Oracle WebCenter Sites supports.

These features automate the process, which dramatically reduces the effort and time required for the export and re-importation of content that needs to be localized. This is very helpful when translating large volumes of content or ensuring that translated content is quickly re-imported to meet deadlines.

When you use the Connector, you manage your translation lifecycle entirely from within Oracle WebCenter Sites:

1. The Connector exports your content from Oracle WebCenter Sites in XML format and delivers these content files to the central, hosted Clay Tablet Platform.

2. The Clay Tablet Platform delivers your content to your translation providers, based on routing rules that your company chooses and Clay Tablet Technologies implements.

3. When the translated content is ready, the Clay Tablet Platform retrieves it from your translators and delivers
it to the Connector.

4. The Connector automatically re-imports the content into the correct location in Oracle WebCenter Sites.

You can then review, revise, reject, or publish the translated content as needed.

**Note:** Neither the Connector nor the Clay Tablet Platform performs any translation. Similarly, Clay Tablet Technologies does not provide any translation services. Your company chooses the translation provider that performs the translation.

### 1.3 Using this Guide

**Purpose of this guide**

This guide describes how to use the Clay Tablet Connector ("Connector") for Oracle WebCenter Sites ("OWCS") to manage your translation lifecycle. It describes how to send out OWCS assets for translation and receive them back from translation.

**Who should use this guide**

This guide is intended for content editors, project, marketing, localization or translation managers, or others who are responsible for creating, editing, or approving assets for translation that reside in your OWCS CMS. This guide is also useful for translation providers who receive assets from your OWCS CMS, because it describes your company's translation management process.

**What your company setup should be**

This document assumes that:

- Your company already has a functioning instance of OWCS.
- The Connector has been installed, configured, and tested on your OWCS instance.
- Clay Tablet Technologies has set up the Clay Tablet Platform to send assets to your translation providers.

**What you should already know**

This document assumes that:

- You are familiar with the Connector's configuration for your OWCS CMS, and the reasons for choosing certain configuration options. This is important because your company's configuration determines which features are available.
- You have a strong working knowledge of OWCS.
- You are familiar with your company's translation process and requirements.
You have valid user credentials to log into OWCS.

You have the required permissions to access the Connector functionality described in this guide.

**Note:** Not all the features described in this guide may be available. Feature availability depends on both your company's Connector setup and the roles to which you are assigned. If you cannot access functionality that you need, contact your company's OWCS administrator.

### How this guide is organized

This guide contains the following chapters:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Welcome to the Clay Tablet Connector for Oracle WebCenter Sites&quot; on page 5</td>
<td>A brief description of the Clay Tablet for OWCS solution and how it fits into the translation lifecycle. It also includes information about this guide and Clay Tablet Technologies Support contact information.</td>
</tr>
<tr>
<td>&quot;Getting Started with the Clay Tablet Connector for Oracle WebCenter Sites&quot; on page 9</td>
<td>How to get started and an overview of the Connector interface and key features.</td>
</tr>
<tr>
<td>&quot;Collecting Assets for Translation&quot; on page 15</td>
<td>How to collect assets for translation.</td>
</tr>
<tr>
<td>&quot;Adding Assets to Translation Jobs&quot; on page 30</td>
<td>How to add collected assets to new or existing translation jobs.</td>
</tr>
<tr>
<td>&quot;Sending Out Jobs for Translation&quot; on page 42</td>
<td>How to send out jobs for translation.</td>
</tr>
<tr>
<td>&quot;Monitoring the Translation Status of Assets and Jobs&quot; on page 44</td>
<td>How to monitor the translation status of assets and jobs that you sent out for translation.</td>
</tr>
<tr>
<td>&quot;Post-Translation Tasks&quot; on page 54</td>
<td>How to perform post-translation tasks, including approving translated assets and archiving jobs.</td>
</tr>
<tr>
<td>&quot;Using Workflow to Manage the Translation Process&quot; on page 60</td>
<td>How to use workflow to manage the translation process. <strong>Important:</strong> This feature is available only if your company has configured the CT: Approval for Content workflow.</td>
</tr>
<tr>
<td>&quot;Administrative Tasks&quot; on page 68</td>
<td>How to perform administrative tasks from the Clay Tablet Dashboard interface.</td>
</tr>
</tbody>
</table>
How to find out more about the Clay Tablet Connector for OWCS

For information on installing and configuring the Clay Tablet Connector for OWCS, read the Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration Guide.

Documentation conventions

This guide uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Highlights screen elements such as buttons, menu items, and fields.</td>
</tr>
<tr>
<td><strong>Courier</strong></td>
<td>Highlights input, file names, and paths.</td>
</tr>
<tr>
<td><strong>Italics</strong></td>
<td>Highlights terms for emphasis, variables, or document titles.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Indicates a menu choice. For example, &quot;Select Translation &gt; Translate Asset.&quot;</td>
</tr>
</tbody>
</table>

1.4 How to Contact Clay Tablet Support

Email @: support@clay-tablet.com
Telephone: +1-416-363-0888 option "3"
2 Getting Started with the Clay Tablet Connector for Oracle WebCenter Sites

The Connector supports all web browsers that Oracle WebCenter Sites ("OWCS") supports.

Recommendation: Use the Firefox browser with the Connector.

To access the Connector:

1. Log in to OWCS.

2. Click the Contributor application icon.

The translation-management interface is primarily available on the Translation menu and in right-click context menus.

Note: To access the Connector configuration and administration interface, after logging in to OWCS, click the Clay Tablet Dashboard application icon.

2.1 Key Features

The Clay Tablet Connector for OWCS ("Connector") has the following key features:

- "Managing Translations with Workflow" on page 9
- "Multiple Ways to Collect Assets for Translation" on page 10
- "Multiple Ways to Manage Collected Assets" on page 10
- "Optimizing Translation" on page 10
- "Selecting a Translation Provider" on page 11

Copying an asset directly from the source locale to the target locale. This is useful when there is content that you do not want to translate, but that you want to include in the target version.

2.1.1 Managing Translations with Workflow

If properly configured, you can use the CT: Approval for Content workflow with the Connector to manage your translations. To use the workflow with the Connector, you put assets in the workflow in the Contributor interface. Using the workflow with the Connector has the following advantages:

- You may receive email notifications when an asset is translated or assigned to you.

- Your company may have extended and integrated the final step of the CT: Approval for Content workflow with other workflows. For example, this workflow may be configured so that the asset is assigned to an additional person for review and approval before publication, for example, a legal review.
You may be able to assign due dates to assets.

You may be able to delegate your assignments to other people.

For more information and detailed instructions, see "Using Workflow to Manage the Translation Process" on page 60.

In order for the workflow process to work as described above, it must be configured. For detailed configuration instructions, refer to the Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration Guide.

2.1.2 Multiple Ways to Collect Assets for Translation

There are multiple ways to use the Connector to collect assets for translation:

- You can collect a single asset for translation. For details, see "Collecting One Asset for Translation" on page 15.

- You can simultaneously collect multiple assets for translation, from either the Site Tree or the Content Tree. For details, see "Collecting Multiple Assets for Translation" on page 21.

2.1.3 Multiple Ways to Manage Collected Assets

There are multiple ways to manage collected assets:

- You can create a new job for the assets. This is described in both "Collecting One Asset for Translation" on page 15 and "Collecting Multiple Assets for Translation" on page 21.

- You can add the collected assets to an existing job. This is described in both "Collecting One Asset for Translation" on page 15 and "Collecting Multiple Assets for Translation" on page 21.

- You can send the collected assets to the Translation Queue, so that you can add them to jobs later. For details, see "Adding Assets in the Translation Queue to Jobs" on page 30.

2.1.4 Optimizing Translation

The Optimize Translation feature helps you reduce translation costs, by reducing the quantity of content that Connector sends to translation providers. It sends only changed content fields out for translation. To do this, it checks each field in the source version of the asset for any content changes, and it sends only changed fields out for translation. If an assets was previously translated and it has not changed, then the Connector does not send it for translation again: Instead, it uses the stored translation.

You specify this feature by selecting the Send Modified Fields Only check box when you collect one or more assets to send out for translation. When this check box is selected, the Connector sends out for translation only changed content fields in the assets. If a field was previously translated and it has not changed, then the Connector does not send it for translation again: Instead, it uses the stored translation.
2.1.5 Selecting a Translation Provider

If your company has multiple translation providers, your company’s Connector setup may enable you to select which one to use when you send out assets for translation.

This feature is available whenever you send out a job for translation.

2.2 The Connector at a Glance

The Connector has two main interfaces in OWCS:

- The **Contributor** interface, which you open by clicking this application icon. This is the part of the Connector that you use for day-to-day translation-management tasks, such as sending out assets for translation, and receiving assets back from the translation provider.
  
  The Connector installs a **Translation** menu in this interface.

  **Important:** If your site has menu customization in the Contributor interface, this may override the Connector’s customization, which can prevent the **Translation** menu from being displayed. If this happens, ask your OWCS administrator to enhance the menu customization in the Contributor interface, so that the site displays the **Translation** menu. For example, the **avisports** site, which is included in the OWSC installation, has menu customization that overrides the Connector’s customization, which prevents the **Translation** menu from being displayed.

- The Connector installs context-menu items.

  Any user with the **CTUser** role for the specified site can access this interface.

- The **Clay Tablet Dashboard** interface, which you open by clicking this application icon. This is the configuration and administration part of the Connector. This interface is described differently, depending on
the role assigned to your user.

**Note:** This guide describes the administration part of this interface, while the *Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration Guide* describes the configuration part of this interface.

![How this interface is displayed to users with the CTUser role:](image1)

![How this interface is displayed to users with the CTSiteAdmin role:](image2)

![How this interface is displayed to users with the CTAdmin role:](image3)
2.3 How to Manage Translations with the Connector

When you use the Connector to manage translating assets in OWCS, you complete the following general steps:
1. Collect assets for translation.

2. Add assets:
   - ☐ to a new job
   - ☐ to an existing job
   - ☐ to the Translation Queue (add these assets to a job later)

3. Optional. If assets were added to a job, save the job.

4. Send out the job for translation.


   The translation provider translates assets, and translated assets return from translation.

   **Note:** If you configure the translation job to put the target asset into a workflow state, then you can configure the workflow steps to send out email alerts when the asset returns from translation. For more information, refer to the appropriate version of the OWCS documentation at [http://www.oracle.com/technetwork/middleware/webcenter/sites/documentation/index.html](http://www.oracle.com/technetwork/middleware/webcenter/sites/documentation/index.html).

6. Approve the translated assets so that they can be published.

7. Optional. Archive the completed job.

   **Note:** Administrators can archive incomplete jobs.
3 Collecting Assets for Translation

The first step in sending assets out for translation is collecting them. After you collect assets, you organize them into jobs. Each job can contain one or more assets.

**Important:** OWCS supports assets that are either Web pages or attachments, such as Microsoft Word files. However, the Connector supports sending out for translation only assets that are Web pages. The Connector does not support sending out for translation assets that are attachments.

You collect assets for translation in the **Contributor** interface:

- When an asset is selected in the **Site Tree** or in the **Content Tree** in the navigation pane on the left, you can select **Translation > Translate Asset** from the menu.
- If the **Site Tree** bar is selected at the bottom of the navigation pane on the left, then you can right-click on an asset in this tree and select **Translate** or **Translate Branch** from the context menu that opens.
- If the **Content Tree** bar is selected at the bottom of the navigation pane on the left, then you can right-click on an asset in this tree and select **Translate** or **Translate Children**.

There are multiple ways to collect assets for translation:

- For instructions on collecting a single asset for translation, see "Collecting One Asset for Translation" on page 15.
- For instructions on collecting multiple assets for translation, see "Collecting Multiple Assets for Translation" on page 21.

  **Note:** When you collect multiple assets, you can filter them so that you add certain ones to specific jobs or you can send them to the Translation Queue. For details, see "Filtering Assets in a List" on page 27.

3.1 Collecting One Asset for Translation

This section describes how to collect a single asset to send for translation. After you collect this asset, you can add it to a new or an existing job, or you can send it to the Translation Queue, so that you can add it to a job later.

To collect one asset for translation:

1. Do one of the following:
   - From the navigation pane, open an asset in the **Site Tree** or the **Content Tree**, and then select **Translation > Translate Asset** from the menu.
   - In the navigation pane, select an asset, right-click, and select **Translate** from the context menu.
   - Open the asset, and select **Translation > Translate Asset** from the menu.
Click the Translate this asset now link in the following scenario: You select Translation > View Translations when an asset is in Form mode and Inspect view, and the asset has not been translated. The following message is displayed: This asset currently has no translations.

The Translate page opens.

2. Specify the following translation options:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the asset, which was specified when the asset was created. Read-only.</td>
</tr>
<tr>
<td>Description</td>
<td>A brief description of the asset, which was specified when the asset was created. Read-only.</td>
</tr>
<tr>
<td>ID</td>
<td>OWCS's unique identifier for the asset. Read-only.</td>
</tr>
<tr>
<td>Locale</td>
<td>The OWCS locale for the source language of the asset to send out for translation. Read-only.</td>
</tr>
</tbody>
</table>
### Field | Description
---|---
Existing Translations | Indicates whether translations already exist for this asset. Read-only.  
- None: There are no translations for this asset.  
- If this asset has previously been translated, then the locales for the translated languages are displayed.
Select Target Workflow | To assign the asset to the translation workflow, select the CT: Approval for Content workflow. Otherwise, select Do Not Add to Workflow. For more information, see "Using Workflow to Manage the Translation Process" on page 60.
Add to Job/Queue | Specifies the job for the asset to the Translation Queue. Select a job or one of the following options from the list:  
- The job name of a job that has not yet been sent out for translation. These are jobs that have Created status.  
- Queue for Later: Sends the asset to the Translation Queue, where it still must be added to a job before you send it out for translation. For a list of reasons for sending an asset to the Translation Queue, see "Adding Assets in the Translation Queue to Jobs" on page 30.  
- Create New Job: Enables you to create a new job for this asset.
Send with Dependencies | When this check box is selected, the Connector sends out any components in the asset for translation as separate assets.
Send Modified Fields Only | Send out for translation only changed content fields in the asset. If a field was previously translated and it has not changed, then the Connector does not send it for translation again: Instead, it uses the stored translation.
Target Locales | Select the check boxes of one or more target locales for translating the asset.  
- To select all locales, click Select All.  
- To clear all selected check boxes, click Select None.  
- To display locales that are hidden by default, click the Show X Hidden Locales link at the bottom of the list, where X is the number of hidden locales. To hide them again, click the Hide X Locales link. Displayed only if some locales have been hidden by default for this site. For more information, refer to the Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration Guide.

3. **Click Next.**

- If you selected Create New Job in the Add to Job/Queue list, a pop-up window opens, prompting you to enter a name for the new job. Enter the name and click OK.
- If you selected Queue for Later in the Add to Job/Queue list, the Translation Queue opens. For details, see "Adding Assets in the Translation Queue to Jobs" on page 30.
- If you added the asset to a new or an existing job, the Job Details page opens.
4. Specify the following translation-job options:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job ID</td>
<td>The Connector's unique identifier for this job. Read-only.</td>
</tr>
<tr>
<td>Job Name</td>
<td>The name of this translation job. You can modify this name.</td>
</tr>
<tr>
<td>Description</td>
<td>The brief description of this translation job. You can modify this description.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of this job, which is Created. For a list and description of translation-job statuses, see page 44.</td>
</tr>
<tr>
<td>Created</td>
<td>The username of the user who created the job, and the date and time when the job was created, in the following format: YYYY-MM-DD hh:mm:ss. Read-only.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Last Updated</td>
<td>The date and time when the job was created, in the following format: YYYY-MM-DD hh:mm:ss. Read-only.</td>
</tr>
<tr>
<td>PO Number</td>
<td>The purchase-order (&quot;PO&quot;) number for this job. Select a PO number from the dropdown list. Depending on your site configuration, this field may be required, optional, or not displayed at all. For more information, refer to the <em>Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration Guide</em>.</td>
</tr>
<tr>
<td>Due Date (yyyy-mm-dd)</td>
<td>The date when the translated asset is due, in the following format: YYYY-MM-DD.</td>
</tr>
<tr>
<td>Translation Provider</td>
<td>Select the translation provider from the dropdown list. If Freeway is selected, the following additional fields are displayed, where you can specify the analysis codes for the translation:</td>
</tr>
<tr>
<td></td>
<td><strong>Region:</strong> The region relevant to the content. Your Lionbridge setup determines which regions are displayed in the list.</td>
</tr>
<tr>
<td></td>
<td><strong>Department:</strong> The department relevant to the content. Your Lionbridge setup determines which departments are displayed in the list.</td>
</tr>
<tr>
<td></td>
<td><strong>Priority:</strong> The priority of this job. Your Lionbridge setup determines which priorities are displayed in the list.</td>
</tr>
<tr>
<td>Assets in this Job</td>
<td><strong>Note:</strong> For an existing job, both the new and the previous assets in the job are displayed. The following information is displayed about the number of assets in this job:</td>
</tr>
<tr>
<td></td>
<td><strong>Total:</strong> The total number of assets in this job, including any assets that were previously added to an existing job.</td>
</tr>
<tr>
<td></td>
<td><strong>Pending:</strong> The number of recently collected assets that can be added to this job.</td>
</tr>
<tr>
<td></td>
<td>The number of assets displayed on this page of the asset list.</td>
</tr>
<tr>
<td></td>
<td>The number of assets in the list with selected check boxes.</td>
</tr>
</tbody>
</table>
### Field | Description
--- | ---
Asset List | The following information about the assets available to send out for translation:
- **Asset Type**: The type of asset.
- **ID**: OWCS's unique identifier for the asset.
- **Asset Name**: The name of the asset, which was specified when the asset was created.
- **Source Locale**: The locale of the source language to send out for translation.

**Tip**: If you are viewing this page from the Contributor interface, you can click the link to view the asset.

- **Target Locale**: The locale of the target language into which to translate the asset.
- **Last Updated**: The date and time when the asset was last updated, in the following format: YYYY-MM-DD hh:mm:ss.

Select the assets to send out for translation.

**Important**: The Connector will send out all the assets in the list for translation. To avoid sending one or more assets for translation, select the corresponding check boxes, and click **Remove Selected** to remove them from the list. A message box opens, confirming that you want to remove the selected assets from the job. Click **OK** to proceed.

If there are more than 10 assets in the list, you can click the page number or change the number of assets displayed in a page to view the other assets.

Use the following buttons to select and manage items in the list:
- **Select All**: Selects all check boxes for the displayed assets.
- **Unselect All**: Clears all selected check boxes for the displayed assets.
- **Remove Selected**: Removes the assets with selected check boxes from the list.

Filter | To display fewer assets in the list, in the **Filter** section in the bottom right corner, change any filter settings and click **Apply**. This section is displayed only if there are 10 or more assets in the list. For detailed instructions, see "Filtering Assets in a List" on page 27.

---

5. Do one of the following:

- To save the job so that you can send it later, click **Save Job**. The Job Details page updates. The **Status** of the Job is **Created**.

- To send the job out for translation immediately, click **Send Now**. A message box opens, confirming that you want to send out this job to the translation provider you specified earlier. Click **OK** to proceed. The **Status** is **Sending**. Click **View Details**. The page updates. The **Status** is **Sent to CT Platform**. In the asset list, the assets have **SENDING_TO_PLATFORM** status. Click the Refresh icon ![refresh icon](https://example.com) to refresh the page.

- To copy the assets in the job directly from the source locale to the target locale, without sending out the job to the translation provider, click **Copy Back**. This is useful when there is content that you do not want to translate, but that you want to include in the target version. A message box opens, confirming that you want to copy over the assets without translating them. Click **OK** to proceed. This overwrites any
corresponding target assets that already exist. The status of the job is Sending to copy back. Click View Details. The page updates. The status is now Completed (copied back).

**Note:** To copy assets from this job to a new or an existing job, in the Copy to dropdown list, either select the name of a job that has not yet been sent out for translation, or select Create New Job, and then click Copy to. For detailed instructions, see "Copying Assets Between Jobs" on page 40.

**Note:** To delete the job before saving or sending it, click Delete Job.

### 3.2 Collecting Multiple Assets for Translation

This section describes how to collect a multiple assets to send for translation. After you collect these assets, you can add them to a new or an existing job, or you can send them to the Translation Queue, so that you can add them to one or more jobs later.

To collect multiple assets for translation:

1. Do one of the following:

   - If the **Content Tree** is displayed in the navigation pane, then select a branch, right-click, and select Translate Children from the context menu.

     **Note:** For a description of what happens if you select Translate from the context menu, see "Collecting One Asset for Translation" on page 15.

   - If the **Site Tree** is displayed in the navigation pane, then select a branch, right-click, and select Translate Branch from the context menu.

     **Note:** For a description of what happens if you select Translate from the context menu, see "Collecting One Asset for Translation" on page 15.

The Translate Children of Asset page or the Translate Branches of Page page opens in a new tab.
Important: When you collect multiple assets for translation, they must all have the same source locale. If necessary, under Refine Search, select the radio button for the source locale of the assets to translate.

2. Ensure that the check boxes of the assets you want to send out for translation are selected, and click Continue. If required, click the Select All and Unselect All buttons to facilitate your selection.

The Translate Multiple Assets of Type page opens.

3. Specify the following translation options:
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of Assets</td>
<td>The number of assets collected. Read-only.</td>
</tr>
<tr>
<td>Locale</td>
<td>The OWCS locale for the source language of the assets to send out for translation. Read-only.</td>
</tr>
<tr>
<td>Select Target Workflow</td>
<td>To assign the assets to the translation workflow, select the CT: Approval for Content workflow. Otherwise, select Do Not Add to Workflow. For more information, see &quot;Using Workflow to Manage the Translation Process&quot; on page 60.</td>
</tr>
</tbody>
</table>
| Add to Job/Queue              | Specifies the job for the assets or sends them to the Translation Queue. Select a job or one of the following options from the list:  
  - The job name of a job that has not yet been sent out for translation. These are jobs that have Created status.  
  - Queue for Later: Sends the assets to the Translation Queue, where they still must be added to a job before you send them out for translation. For a list of reasons for sending an asset to the Translation Queue, see "Adding Assets in the Translation Queue to Jobs" on page 30.  
  - Create New Job: Enables you to create a new job for these assets.  |
| Send with Dependencies        | When this check box is selected, the Connector sends out any components in the assets for translation as separate assets.                                                                                                                                                                                                                       |
| Send Modified Fields Only     | When this check box is selected, the Connector sends out for translation only changed content fields in the assets. If a field was previously translated and it has not changed, then the Connector does not send it for translation again: Instead, it uses the stored translation.                                                                                                           |
| Target Locales                | Select the check boxes of one or more target locales for translating the assets.  
  - To select all locales, click Select All.  
  - To clear all selected check boxes, click Select None.  
  - To display locales that are hidden by default, click the Show X Hidden Locales link at the bottom of the list, where X is the number of hidden locales. To hide them again, click the Hide X Locales link. Displayed only if some locales have been hidden by default for this site. For more information, refer to the Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration Guide. |

4. Click Next.

- If you selected Create New Job in the Add to Job/Queue list, a pop-up window opens, prompting you to enter a name for the new job. Enter the name and click OK.
If you selected Queue for Later in the Add to Job/Queue list, the Translation Queue opens. For details, see "Adding Assets in the Translation Queue to Jobs" on page 30.

If you added the assets to a new or an existing job, the Translate Multiple Assets of Type page opens.

The Job Details page opens.

Any assets that are displayed in the list are part of the job and may be sent for translation.

5. Verify the assets in the job, and specify the following translation-job settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job ID</td>
<td>The Connector's unique identifier for this job. Read-only.</td>
</tr>
<tr>
<td>Job Name</td>
<td>The name of this translation job. You can modify this name.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Job Description</td>
<td>The brief description of this translation job. You can modify this description.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of this job, which is Created. For a list and description of translation-job statuses, see page 44.</td>
</tr>
<tr>
<td>Created</td>
<td>The username of the user who created the job, and the date and time when the job was created, in the following format: YYYY-MM-DD hh:mm:ss. Read-only.</td>
</tr>
<tr>
<td>Last Updated</td>
<td>The date and time when the job was created, in the following format: YYYY-MM-DD hh:mm:ss. Read-only.</td>
</tr>
<tr>
<td>PO Number</td>
<td>The purchase-order (&quot;PO&quot;) number for this job. Select the PO number from the dropdown list. Depending on your site configuration, this field may be required, optional, or not displayed at all. For more information, refer to the Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration Guide.</td>
</tr>
<tr>
<td>Due Date</td>
<td>The date when the translated asset is due, in the following format: YYYY-MM-DD.</td>
</tr>
<tr>
<td>Translation Provider</td>
<td>Select the translation provider from the dropdown list. If Freeway is selected, the following additional fields are displayed, where you can specify the analysis codes for the translation:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Region:</strong> The region relevant to the content. Your Lionbridge setup determines which regions are displayed in the list.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Department:</strong> The department relevant to the content. Your Lionbridge setup determines which departments are displayed in the list.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Priority:</strong> The priority of this job. Your Lionbridge setup determines which priorities are displayed in the list.</td>
</tr>
<tr>
<td>Assets in this Job</td>
<td><strong>Note:</strong> For an existing job, both the new and the previous assets in the job are displayed. The following information is displayed about the number of assets in this job:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Total:</strong> The total number of assets in this job, including any assets that were previously added to an existing job.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Pending:</strong> The number of recently collected assets that can be added to this job.</td>
</tr>
<tr>
<td></td>
<td>- The number of assets displayed on this page of the asset list.</td>
</tr>
<tr>
<td></td>
<td>- The number of assets in the list with selected check boxes.</td>
</tr>
</tbody>
</table>
3 Collecting Assets for Translation

3.2 Collecting Multiple Assets for Translation

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset List</td>
<td>The following information about the assets available to send out for translation:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Asset Type:</strong> The type of asset.</td>
</tr>
<tr>
<td></td>
<td>- <strong>ID:</strong> OWCS's unique identifier for the asset.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Asset Name:</strong> The name of the asset, which was specified when the asset was created.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Source Locale:</strong> The locale of the source language to send out for translation.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> If you are viewing this page from the Contributor interface, you can click the link to view the asset.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Target Locale:</strong> The locale of the target language into which to translate the asset.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Last Updated:</strong> The date and time when the asset was last updated, in the following format: <code>YYYY-MM-DD hh:mm:ss</code>.</td>
</tr>
<tr>
<td></td>
<td>Select the assets to send out for translation.</td>
</tr>
<tr>
<td></td>
<td><strong>Important:</strong> The Connector will send out all the assets in the list for translation. To avoid sending one or more assets for translation, select the corresponding check boxes, and click <strong>Remove Selected</strong> to remove them from the list. A message box opens, confirming that you want to remove the selected assets from the job. Click <strong>OK</strong> to proceed.</td>
</tr>
<tr>
<td></td>
<td>If there are more than 10 assets in the list, you can click the page number or change the number of assets displayed in a page to view the other assets.</td>
</tr>
<tr>
<td></td>
<td>Use the following buttons to select and manage items in the list:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Select All:</strong> Selects all check boxes for the displayed assets.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Unselect All:</strong> Clears all selected check boxes for the displayed assets.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Remove Selected:</strong> Removes the assets with selected check boxes from the list.</td>
</tr>
<tr>
<td>Filter</td>
<td>To display fewer assets in the list, in the <strong>Filter</strong> section in the bottom right corner, change any filter settings and click <strong>Apply</strong>. This section is displayed only if there are 10 or more assets in the list. For detailed instructions, see &quot;Filtering Assets in a List&quot; on page 27.</td>
</tr>
</tbody>
</table>

**Note:** To delete one or more assets from the job, select the corresponding check boxes and click **Delete Selected**. A message box opens, confirming that you want to remove the selected assets from the job. Click **OK** to proceed.

6. Do one of the following:

- To save the job so that you can send it later, click **Save Job**. The Job Details page updates. The **Status** of the Job is **Created**.
- To send the job out for translation immediately, click **Send Now**. A message box opens, confirming that you want to send out this job to the translation provider you specified earlier. Click **OK** to proceed. The **Status** is **Sending**. Click **View Details**. The page updates. The **Status** is **Sent to CT Platform**. In the asset list, the assets have **SENDING_TO_PLATFORM** status. Click the **Refresh** icon to refresh the page.
- To copy the assets in the job directly from the source locale to the target locale, without sending out the job to the translation provider, click **Copy Back**. This is useful when there is content that you do not want
to translate, but that you want to include in the target version. A message box opens, confirming that you want to copy over the assets without translating them. Click OK to proceed. This overwrites any corresponding target assets that already exist. The status of the job is Sending to copy back. Click View Details. The page updates. The status is now Completed (copied back).

Note: To copy assets from this job to a new or an existing job, in the Copy to dropdown list, either select the name of a job that has not yet been sent out for translation, or select Create New Job, and then click Copy to. For detailed instructions, see "Copying Assets Between Jobs" on page 40.

Note: To delete the job before saving or sending it, click Delete Job.

3.3 Filtering Assets in a List

The following pages display lists of assets
- The Job Details page displays the list of assets in a job.
- The Translation Queue display the list of assets in the queue.

If there are more than 10 assets in the asset list:
- The assets are displayed on multiple pages.
- You can filter the assets displayed in the list, as described in this section.

When you filter a list, you specify one or more filter conditions. A filter condition is active and modifiable only if it has multiple possible values. For example, suppose that the Translation Queue contains assets that will be translated into multiple target locales. You can see this in the Target Locale list, in the screen capture below.

Now suppose that you want to create a job with assets only for a particular locale (fr_FR), so that you can send these assets for translation to a particular translation provider.

You can filter the list of assets in the Translation Queue to display only those with the fr_FR locale.

To filter assets in the list:
1. In the **Filter** section, to the right of the asset list, click the expand icon beside the condition to filter. For example, click the expand icon beside **Target Locale**.

- Conditions in black are available for filtering. This means that assets have different values for this particular condition. For example, the target locale for all the assets are **de_DE**, **es_ES**, and **fr_FR**.
- Conditions in gray are not available for filtering, because all the assets have the same value for this condition. For example, the source locale for all the assets is **en_US**.

![Translation Queue](image)

The **Target locale** section expands.

![Filter](image)
2. Specify the value to filter. The interface depends on the type of condition. For example, for the **Target locale**, select the check boxes for the target locales to filter. Then the page will display only assets that will be translated to the specified target locale.

You can filter the following conditions:

<table>
<thead>
<tr>
<th>Condition</th>
<th>Filter Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Name</td>
<td>Select one of the following parameters: contains/matches/like, and then enter the asset name or fragment in the text box.</td>
</tr>
<tr>
<td>Asset Type</td>
<td>Displays all the asset types of the assets in the asset list. Select the corresponding check boxes.</td>
</tr>
<tr>
<td>Source Locale</td>
<td>Displays all the source locales of the assets in the asset list. Select the corresponding check boxes.</td>
</tr>
<tr>
<td>Target Locale</td>
<td>Displays all the target locales of the assets in the asset list. Select the corresponding check boxes.</td>
</tr>
<tr>
<td>Update Date</td>
<td>Select one of the following parameters: on/before/after/between, and then enter the date or dates when the asset was last updated, in the following format: YYYY-MM-DD.</td>
</tr>
<tr>
<td>Created User</td>
<td>Displays all the users who created the assets in the asset list. Select the corresponding check boxes.</td>
</tr>
<tr>
<td>Site</td>
<td>Displays all the sites with the assets in the asset list. Select the corresponding check boxes. Note: This filter is displayed only in the Clay Tablet Dashboard interface.</td>
</tr>
</tbody>
</table>

**Note:** To cancel a condition, click the red close icon [x]. This removes the corresponding condition from the filter.

3. Click **Apply**.

The asset list now displays only the assets that match the specified filter conditions.
4 Adding Assets to Translation Jobs

After you collect assets, you add them to new or existing translation jobs.

- You can add assets to translation jobs immediately after you collect them.
  - For detailed instructions on collecting a single asset and immediately adding it to a job, see "Collecting One Asset for Translation" on page 15.
  - For detailed instructions on collecting multiple assets and immediately adding them to jobs, see "Collecting Multiple Assets for Translation" on page 21.
- You can add collected assets to the Translation Queue. Later, you add the collected assets from the Translation Queue to new or existing translation jobs. For details, see "Adding Assets in the Translation Queue to Jobs" on page 30.

Note: Even after you add assets to a translation job, you can still modify that job and add or remove assets, and change job settings. For details, see "Modifying a Job before Sending It Out for Translation" on page 36.

4.1 Adding Assets in the Translation Queue to Jobs

The Translation Queue contains assets that you collected and did not immediately add to jobs. From the Translation Queue, you can add one, multiple, or all of these previously collected assets to a new or an existing job. You can then also send out this job for translation. Submitting assets to the Translation Queue before sending it out for translation has the following advantages:

- You may have assets that you want to send out for translation, but you may not have decided yet how you want to organize these assets into jobs.
- You may not want to send out each asset individually as soon as you collect it. The Translation Queue facilitates your management of assets, so that you do not forget about sending individual assets for translation.
- Your translation provider may prefer receiving fewer but larger batches of assets to translate, rather than individual assets, as it facilitates project preparation, resource assignment, and file analysis.
- If you want to translate many assets into multiple languages, but you want to translate into only one target language at a time, this is a good way to manage that process.
- You may want to route jobs to certain translation providers.
- You may want to add job-specific metadata, such as a purchase order number.

You submit assets for translation from the Translation Queue in the following scenarios:

- You collect a single asset for translation, and you send it to the Translation Queue. For details, see "Collecting One Asset for Translation" on page 15.
You collect multiple child assets of a branch of the Content Tree, or a branch of the Site Tree, for translation, and you send them to the Translation Queue. For details, see "Collecting Multiple Assets for Translation" on page 21.

To open the Translation Queue:

- In the Contributor interface, select **Translation > Translation Queue**.
- In the Clay Tablet Dashboard interface, under **Management**, click **View All Queues**.
- In the Contributor interface, select **Queue for Later** in the **Add to Job/Queue** dropdown list while collecting assets for translation, either:
  - in the **Translate** page, described in "Collecting One Asset for Translation" on page 15
  - in the **Translate Multiple Assets of Type** page, described in "Collecting Multiple Assets for Translation" on page 21

The Translation Queue ("queue") displays all assets that were previously collected for translation, were sent to the Translation Queue, and have not yet been added to translation jobs for a particular site.

**Tip:** To update your view of the assets in the Translation Queue, click **Refresh** in the top-left corner of the page.

**Note for administrators:** If you are assigned either to the **CTSiteAdmin** role for multiple sites or to the **CTAdmin** role, and you open the **Translation Queue** from the Clay Tablet Dashboard interface, then you can use the **Site** dropdown list in the top right corner of the queue to select which site's assets to view.

If there are more than 10 assets in the queue, the assets are displayed in multiple pages in the queue.

- To navigate among pages in the list, click the corresponding page number.
- To display more assets in a page, select the number to display (20, 50, 100) from the dropdown list.
- To display fewer assets in the list, in the **Filter** section in the bottom right corner, change any filter settings and click **Apply**. This section is displayed only if there are 10 or more assets in the list. For detailed instructions, see "Filtering Assets in a List" on page 27.
The following information is displayed about assets in the Translation Queue:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Type</td>
<td>The type of asset.</td>
</tr>
<tr>
<td>ID</td>
<td>OWCS's unique identifier for the asset.</td>
</tr>
<tr>
<td>Asset Name</td>
<td>The name of the asset, which was specified when the asset was created.</td>
</tr>
<tr>
<td>Source Locale</td>
<td>The locale of the source language to send out for translation.</td>
</tr>
<tr>
<td><strong>Tip:</strong></td>
<td>If you are viewing this page from the Contributor interface, you can click the link to view the asset.</td>
</tr>
<tr>
<td>Target Locale</td>
<td>The locale of the target language into which to translate the asset.</td>
</tr>
<tr>
<td>Last Updated</td>
<td>The date and time when the asset was last updated, in the following format: YYYY-MM-DD hh:mm:ss.</td>
</tr>
</tbody>
</table>

Once the assets to you want to group together are displayed in the list, you add them to a job.

To add one or more assets in the queue to a job:

1. Select the check boxes for the assets to add to a job.

   **Tip:** To facilitate this, use the Select All and Unselect All buttons, or click the check box in the column heading.

   **Note:** To delete one or more assets from the queue, select the corresponding check boxes and click Delete Selected. A message box opens, confirming that you want to remove the selected assets from the queue. Click OK to proceed. The deleted assets are no longer available to add to jobs directly from the queue.

2. In the job dropdown list, do one of the following:

   ![Add to Job](image)

   - Select the job name of a job that has not yet been sent out for translation. These are jobs that have Created status.
   - Select New Job, to create a new job for the selected assets.

3. Click Add to Job.
If you selected New Job in the job dropdown list, a pop-up window opens, prompting you to enter a name for the new job. Enter the name and click OK.

A green message is displayed for a few seconds at the top of the page, stating the number of assets that were added to the job.

The Job Details page opens, displaying information about the new or updated job. You use this page to specify job settings, and you can also modify the assets in this job.

Any assets that are displayed in the list are part of the job and may be sent for translation.

4. Verify the assets in the job, and specify the following translation-job settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job ID</td>
<td>The Connector's unique identifier for this job. Read-only.</td>
</tr>
<tr>
<td>Job Name</td>
<td>The name of this translation job. You can modify this name.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Job Description</td>
<td>The brief description of this translation job. You can modify this description.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of this job, which is <em>Created</em>. For a list and description of translation-job statuses, see page 44.</td>
</tr>
<tr>
<td>Created</td>
<td>The username of the user who created the job, and the date and time when the job was created, in the following format: YYYY-MM-DD hh:mm:ss. Read-only.</td>
</tr>
<tr>
<td>Last Updated</td>
<td>The date and time when the job was created, in the following format: YYYY-MM-DD hh:mm:ss. Read-only.</td>
</tr>
<tr>
<td>PO Number</td>
<td>The purchase-order (&quot;PO&quot;) number for this job. Select the PO number from the dropdown list. Depending on your site configuration, this field may be required, optional, or not displayed at all. For more information, refer to the <em>Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration Guide</em>.</td>
</tr>
<tr>
<td>Due Date</td>
<td>The date when the translated asset is due, in the following format: YYYY-MM-DD.</td>
</tr>
</tbody>
</table>
| Translation Provider | Select the translation provider from the dropdown list. If Freeway is selected, the following additional fields are displayed, where you can specify the analysis codes for the translation:  
  - **Region**: The region relevant to the content. Your Lionbridge setup determines which regions are displayed in the list.  
  - **Department**: The department relevant to the content. Your Lionbridge setup determines which departments are displayed in the list.  
  - **Priority**: The priority of this job. Your Lionbridge setup determines which priorities are displayed in the list. |
| Assets in this Job | **Note**: For an existing job, both the new and the previous assets in the job are displayed. The following information is displayed about the number of assets in this job:  
  - **Total**: The total number of assets in this job, including any assets that were previously added to an existing job.  
  - **Pending**: The number of recently collected assets that can be added to this job.  
  - The number of assets displayed on this page of the asset list.  
  - The number of assets in the list with selected check boxes. |
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset List</td>
<td>The following information about the assets available to send out for translation:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Asset Type:</strong> The type of asset.</td>
</tr>
<tr>
<td></td>
<td>- <strong>ID:</strong> OWCS’s unique identifier for the asset.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Asset Name:</strong> The name of the asset, which was specified when the asset was created.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Source Locale:</strong> The locale of the source language to send out for translation.</td>
</tr>
<tr>
<td></td>
<td><strong>Tip:</strong> If you are viewing this page from the Contributor interface, you can click the link to view the asset.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Target Locale:</strong> The locale of the target language into which to translate the asset.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Last Updated:</strong> The date and time when the asset was last updated, in the following format: YYYY-MM-DD hh:mm:ss.</td>
</tr>
<tr>
<td></td>
<td>Select the assets to send out for translation.</td>
</tr>
<tr>
<td></td>
<td><strong>Important:</strong> The Connector will send out all the assets in the list for translation. To avoid sending one or more assets for translation, select the corresponding check boxes, and click <strong>Remove Selected</strong> to remove them from the list. A message box opens, confirming that you want to remove the selected assets from the job. Click <strong>OK</strong> to proceed.</td>
</tr>
<tr>
<td></td>
<td>If there are more than 10 assets in the list, you can click the page number or change the number of assets displayed in a page to view the other assets. Use the following buttons to select and manage items in the list:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Select All:</strong> Selects all check boxes for the displayed assets.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Unselect All:</strong> Clears all selected check boxes for the displayed assets.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Remove Selected:</strong> Removes the assets with selected check boxes from the list.</td>
</tr>
<tr>
<td>Filter</td>
<td>To display fewer assets in the list, in the <strong>Filter</strong> section in the bottom right corner, change any filter settings and click <strong>Apply</strong>. This section is displayed only if there are 10 or more assets in the list. For detailed instructions, see &quot;Filtering Assets in a List&quot; on page 27.</td>
</tr>
</tbody>
</table>

5. Do one of the following:

- To save the job so that you can send it later, click **Save Job**. The Job Details page updates. The **Status** of the Job is **Created**.

- To send the job out for translation immediately, click **Send Now**. A message box opens, confirming that you want to send out this job to the translation provider you specified earlier. Click **OK** to proceed. The **Status** is **Sending**. Click **View Details**. The page updates. The **Status** is **Sent to CT Platform**. In the asset list, the assets have **SENDING_TOPLATFORM** status. Click the Refresh icon ![Refresh Icon](image) to refresh the page.

- To copy the assets in the job directly from the source locale to the target locale, without sending out the job to the translation provider, click **Copy Back**. This is useful when there is content that you do not want to translate, but that you want to include in the target version. A message box opens, confirming that you want to copy over the assets without translating them. Click **OK** to proceed. This overwrites any
corresponding target assets that already exist. The status of the job is Sending to copy back. Click View Details. The page updates. The status is now Completed (copied back).

**Note:** To copy assets from this job to a new or an existing job, in the Copy to dropdown list, either select the name of a job that has not yet been sent out for translation, or select Create New Job, and then click Copy to. For detailed instructions, see "Copying Assets Between Jobs" on page 40.

**Note:** To delete the job before saving or sending it, click Delete Job.

### 4.2 Modifying a Job before Sending It Out for Translation

If you have saved a job, then before you send it out for translation, you can make the following changes to it:

- You can add assets to the job.
- You can remove assets from the job.
- You can modify the settings of the job.

To modify a saved job:

1. **Do one of the following:**
   - In the Contributor interface, select **Translation > Job Status** from the menu.
   - In the Clay Tablet Dashboard interface, under **Management**, click **View All Jobs**.

The Translation Jobs page opens. For a detailed description of this page, see "Monitoring All Translation Jobs" on page 45.

2. **In the Active Jobs section, click the link in the Name column for the job to modify.**

   **Note:** The job must have Created status, which indicates that it has not yet been sent out for translation.

   The Job Details page opens.
Any assets that are displayed in the list are part of the job and may be sent for translation.

3. Verify the assets in the job, and specify or update the following translation-job settings:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job ID</td>
<td>The Connector's unique identifier for this job. Read-only.</td>
</tr>
<tr>
<td>Job Name</td>
<td>The name of this translation job. You can modify this name.</td>
</tr>
<tr>
<td>Job Description</td>
<td>The brief description of this translation job. You can modify this description.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of this job, which is Created. For a list and description of translation-job statuses, see page 44.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Created</td>
<td>The username of the user who created the job, and the date and time when the job was created, in the following format: YYYY-MM-DD hh:mm:ss. Read-only.</td>
</tr>
<tr>
<td>Last Updated</td>
<td>The date and time when the job was created, in the following format: YYYY-MM-DD hh:mm:ss. Read-only.</td>
</tr>
<tr>
<td>PO Number</td>
<td>The purchase-order (“PO”) number for this job. Select the PO number from the dropdown list. Depending on your site configuration, this field may be required, optional, or not displayed at all. For more information, refer to the Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration Guide.</td>
</tr>
<tr>
<td>Due Date</td>
<td>The date when the translated asset is due, in the following format: YYYY-MM-DD.</td>
</tr>
</tbody>
</table>
| Translation Provider | Select the translation provider from the dropdown list. If Freeway is selected, the following additional fields are displayed, where you can specify the analysis codes for the translation:  
  - **Region**: The region relevant to the content. Your Lionbridge setup determines which regions are displayed in the list.  
  - **Department**: The department relevant to the content. Your Lionbridge setup determines which departments are displayed in the list.  
  - **Priority**: The priority of this job. Your Lionbridge setup determines which priorities are displayed in the list. |
| Assets in this Job | **Note**: For an existing job, both the new and the previous assets in the job are displayed.  
The following information is displayed about the number of assets in this job:  
  - **Total**: The total number of assets in this job, including any assets that were previously added to an existing job.  
  - **Pending**: The number of recently collected assets that can be added to this job.  
  - The number of assets displayed on this page of the asset list.  
  - The number of assets in the list with selected check boxes. |
4. Do one of the following:

- To save the job so that you can send it later, click **Save Job**. The Job Details page updates. The **Status** of the Job is **Created**.

- To send the job out for translation immediately, click **Send Now**. A message box opens, confirming that you want to send out this job to the translation provider you specified earlier. Click **OK** to proceed. The **Status** is **Sending**. Click **View Details**. The page updates. The **Status** is **Sent to CT Platform**. In the asset list, the assets have **SENDING_TO_PLATFORM** status. Click the Refresh icon ✯ to refresh the page.

- To copy the assets in the job directly from the source locale to the target locale, without sending out the job to the translation provider, click **Copy Back**. This is useful when there is content that you do not want to translate, but that you want to include in the target version. A message box opens, confirming that you want to copy over the assets without translating them. Click **OK** to proceed. This overwrites any
corresponding target assets that already exist. The status of the job is Sending to copy back. Click View Details. The page updates. The status is now Completed (copied back).

**Note:** To copy assets from this job to a new or an existing job, in the Copy to dropdown list, either select the name of a job that has not yet been sent out for translation, or select Create New Job, and then click Copy to. For detailed instructions, see "Copying Assets Between Jobs" on page 40.

**Note:** To delete the job, click Delete Job.

---

### 4.3 Copying Assets Between Jobs

You can copy assets from one job to another. This is useful if you send out one job for translation, and most of the assets in the job are translated, but others are not, or they need updates. This feature facilitates copying assets into a new job, without locating them first in the Site Tree or the Content Tree. You copy assets from one job to another in the Job Details page.

To copy assets from one job to another:

1. If the Job Details page is not already open:
   a. Select Translation > Job Status from the menu to open the Translation Jobs page.
   b. In the Name column, click the link for the job from which to copy assets.

   For more information about the Translation Jobs page, see "Monitoring All Translation Jobs" on page 45.

   The Job Details page opens.

2. Scroll down to the asset list, at the bottom of the page.

3. Select the check boxes for the assets to add to another job.

4. In the dropdown list beside the Copy to button, do one of the following:
   - Select the name of a job that has not yet been sent out for translation. These are jobs that have Created status.
Select Create New Job, to create a new job for the selected assets.

5. Click Copy to. A message box opens, confirming that you want to copy the selected assets to the new or specified translation job. Click OK to proceed.

6. If you are creating a new job, a pop-up window opens, prompting you to enter a name for the new job. Enter the name and click OK.

A message box opens, asking if you want to view the job to which you added the assets.

7. Do one of the following:
   - Click OK to view this job.
   - Click Cancel to view the previous job.

The Job Details page opens. You can send or save this job.

For more information about the Job Details page, see "Modifying a Job before Sending It Out for Translation" on page 36.
5 Sending Out Jobs for Translation

Whenever you send out a job for translation, you send it out from the **Job Details** page.

The **Job Details** page opens automatically in the following scenarios:

- You collect a single asset to send out for translation, and you add it to a new or an existing job. For details, see "Collecting One Asset for Translation" on page 15.

- You collect multiple assets to send out for translation, and you add them to a new or an existing job. For details, see "Collecting Multiple Assets for Translation" on page 21.

- In the **Translation Queue**, you add one or more queued assets to a new or an existing job. For details, see "Adding Assets in the Translation Queue to Jobs" on page 30.

In these scenarios, you can either immediately send out the job for translation, or you can save it, so that you can send it out later.

To send out a previously saved job for translation:

1. Do one of the following:
   - In the Contributor interface, select **Translation > Job Status** from the menu.
   - In the Clay Tablet Dashboard interface, under **Management**, click **View All Jobs**.

   The **Translation Jobs** page opens. For a detailed description of this page, see "Monitoring All Translation Jobs" on page 45.

2. In the **Active Jobs** section, click the link in the **Name** column for the job to modify.

   **Note:** The job must have **Created** status, which indicates that it has not yet been sent out for translation.

   The **Job Details** page opens.

3. Optional. Add or remove assets in the job, and specify or update the translation-job settings. For a detailed description of this page and these settings, see "Modifying a Job before Sending It Out for Translation" on page 36.

4. Click **Send Now**.

   A message box opens, confirming that you want to send out this job to the specified translation provider. Click **OK** to proceed.

   The **Job Details** page refreshes.

5. To view the translation progress of this job, click **View Details**.

   The page updates.

6. The **Status** is **Sent to CT Platform**. In the asset list, the assets have **SENDING_TOPLATFORM** status.

   Click the **Refresh icon**
5 Sending Out Jobs for Translation

 refresh the page.
6 Monitoring the Translation Status of Assets and Jobs

After you send out a job for translation, you can monitor its progress:

- You monitor the translation status of multiple jobs in the Translation Jobs page. For details, see "Monitoring All Translation Jobs" on page 45.

- You monitor the translation status of a single job and the assets within that job in the Job Details page.

**Note:** If you configure the translation job to put the target asset into a workflow state, then you can configure the workflow steps to send out email alerts when the asset returns from translation. For more information, refer to the appropriate version of the OWCS documentation at [http://www.oracle.com/technetwork/middleware/webcenter/sites/documentation/index.html](http://www.oracle.com/technetwork/middleware/webcenter/sites/documentation/index.html).

- For information on using a workflow, see "Using Workflow to Manage the Translation Process" on page 60.

- For information on configuring a workflow, refer to the Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration Guide.

### 6.1 Translation Statuses

Translation jobs and assets can have the following statuses:

<table>
<thead>
<tr>
<th>Job Status</th>
<th>Job Status Description</th>
<th>Corresponding Asset Status</th>
<th>Asset Status Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>The Connector created the job.</td>
<td>PENDING</td>
<td>The Connector added the assets to a job.</td>
</tr>
<tr>
<td>Sending</td>
<td>The Connector is sending the job to the Clay Tablet Platform for forwarding to the translation provider.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sent to CT Platform</td>
<td>The Connector sent the job to the Clay Tablet Platform for forwarding to the translation provider.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The Connector sent the assets to the Clay Tablet Platform for forwarding to the translation provider.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>The Clay Tablet Platform sent the assets to the translation provider.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sending to copy back</td>
<td>The Connector is preparing to copy the assets in the job from the source locale to the target locale, without sending them out for translation.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PENDING</td>
<td></td>
<td>The Connector is copying the asset from the source locale to the target locale.</td>
</tr>
</tbody>
</table>
### 6.2 Monitoring All Translation Jobs

You can monitor the status of all translation jobs on a single page, from either the Contributor interface or the Clay Tablet Dashboard interface.

To view the status of all translation jobs:

1. To open the **Translation Jobs** page, do one of the following:
   - In the Contributor interface, select **Translation > Job Status** from the menu.
   - In the Clay Tablet Dashboard interface, under **Management**, click **View All Jobs**.

   The **Translation Jobs** page opens. The page is displayed slightly differently, depending on how you open it:
   - This page in the Contributor interface:
This page in the Clay Tablet Dashboard interface:

---

6 Monitoring the Translation Status of Assets and Jobs

6.2 Monitoring All Translation Jobs
In both versions of this page, the jobs are divided into two lists:

- The **Active Jobs** list has translation jobs that have not yet been completed. For example, if you have not yet approved the translation of assets in a job, then the job is incomplete.

- The **Inactive Jobs** list has translation jobs that have been completed, including the final step, which is approval of the translation. For example, if you have approved the translation of all the assets in a job, then the job is complete.

**Tip:** To update your view of the jobs and statuses, click **Refresh** in the top-left corner of the page.

**Note for administrators:** If you are assigned either to the **CTSiteAdmin** role for multiple sites or to the **CTAdmin** role, and you open this page from the Clay Tablet Dashboard interface, then you can use the **Site** dropdown list in the top right corner of the page to select which site’s jobs to view.

The translation jobs are displayed in reverse chronological order by the date that they were last updated.

- To reverse the sort order, click the **Updated** column heading.

The following information is displayed about each translation job in the lists:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the translation job.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the translation job.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the translation job. For a list and description of all statuses, see &quot;Translation Statuses&quot; on page 44.</td>
</tr>
<tr>
<td># of Assets</td>
<td>The number of assets in the translation job.</td>
</tr>
<tr>
<td>Due Date</td>
<td>The due date of the translation job, if one was specified, in the following format: <em>YYYY-MM-DD</em>.</td>
</tr>
<tr>
<td>Provider</td>
<td>The translation provider for the translation job.</td>
</tr>
<tr>
<td>Site ID</td>
<td>The OWCS site where the assets in the translation job are located. Displayed only in the Clay Tablet Dashboard interface.</td>
</tr>
<tr>
<td>Created</td>
<td>The username of the user who created the translation job. Displayed only in the Clay Tablet Dashboard interface.</td>
</tr>
<tr>
<td>Updated</td>
<td>The date the translation job was last updated, in the following format: <em>YYYY-MM-DD</em>.</td>
</tr>
<tr>
<td>Submitted</td>
<td>The date the translation job was submitted to the translation provider for translation, in the following format: <em>YYYY-MM-DD</em>.</td>
</tr>
</tbody>
</table>

2. You can perform the following actions on this page:
   - To view the status of the assets in a translation job, click the link in the **Status** column.
6 Monitoring the Translation Status of Assets and Jobs

6.3 Monitoring Assets in a Single Job

When you send out a job, it is always from the Job Details page. After you send out a job, the job status, which is displayed in the Status field, changes from Created to Sending.

To monitor the translation progress of the jobs and the assets in the job:

1. After sending out a job for translation, in the Job Details page, click View Details.

   The Job Details page expands.
6 Monitoring the Translation Status of Assets and Jobs

6.3 Monitoring Assets in a Single Job

The Status is **Sent to CT Platform**. In the asset list, the assets have **SENDING_TOPLATFORM** status.

2. Click the Refresh icon \[\[ to refresh the page and watch the statuses change.

   ▶ The Status field displays the job status.

   ▶ In the asset list, the Status column displays the asset status.

   For a list and description of all job and asset statuses, see "Translation Statuses" on page 44.

3. Optional If the asset status is **Review Translation** or **Completed**, click the corresponding link in the Status column in the asset list.

   The Translation request detail window opens.
This window displays the following information about the translated asset, which is useful for troubleshooting:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source Asset</td>
<td>The name of the source asset, which was specified when the asset was created, and OWCS's identifier for this asset.</td>
</tr>
<tr>
<td>Target Asset</td>
<td>The name of the target (translated) asset, which is the same as the name of the source asset, and OWCS's identifier for this asset.</td>
</tr>
<tr>
<td>Source Locale</td>
<td>The locale of the language of the source asset, which was sent out for translation.</td>
</tr>
<tr>
<td>Target Locale</td>
<td>The locale of the language of the target asset, which is the translated asset.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of the asset. For a list and description of these statuses, see &quot;Translation Statuses&quot; on page 44.</td>
</tr>
<tr>
<td>Job ID</td>
<td>The Connector's unique identifier for this job.</td>
</tr>
<tr>
<td>Asset ID</td>
<td>The Connector's unique identifier for this asset.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Task ID</td>
<td>The Connector’s unique identifier for this <em>asset task</em>. Asset tasks are either assets (source content for translation) or target-specific translation tasks for translating a particular content item (asset). The task of translating a particular asset (content item) into a single language is a single asset task. Therefore suppose a content item will be translated into both French and German. The asset is the content item in the source language. There are three asset tasks: the original content item; the translation of the content item into French; and the translation of the content item into German.</td>
</tr>
<tr>
<td>Job Provider Ref.</td>
<td>The translation provider’s reference for this job, if it is available.</td>
</tr>
<tr>
<td>Asset Provider Ref.</td>
<td>The translation provider’s reference for this asset, if it is available.</td>
</tr>
</tbody>
</table>

For a detailed description of the other fields and columns in the Job Details page, see "Modifying a Job before Sending It Out for Translation" on page 36.

### 6.4 Checking an Asset’s Translation Status

When an asset is open in OWCS, you can check its translation status. This means you can see the status of the asset in all the relevant locales.

To check an asset’s translation status:

1. In the **Site Tree** or the **Content Tree**, double-click an asset to open it.

2. Select **Translation > Asset Translation Status** from the menu.

   The **Translation Status** page opens.
This page displays information about all translation requests relevant to this asset. It is organized into the following sections:

- **Waiting for approval**: Displays assets that were received back from translation, but which have not yet been approved. These assets have **Reviewing translation status**.
- **Active**: Displays assets that have not yet been sent out for translation. These assets have **Reviewing translation status**.
- **Inactive**: Displays assets that were received back from translation, and which were already approved. These assets have **Completed (translation approved) status**.

If there are no translation requests relevant to a section, then a message to that effect is displayed instead.

This page displays the following information about each asset:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Name</td>
<td>The name of this translation job.</td>
</tr>
<tr>
<td>Job Status</td>
<td>The status of this job. For a list and description of job statuses, see &quot;Translation Statuses&quot; on page 44.</td>
</tr>
<tr>
<td>JobSubmitted</td>
<td>The date the job was submitted, in the following format: YYYY-MM-DD. Not relevant for active jobs, which have not yet been submitted for translation.</td>
</tr>
<tr>
<td>Provider</td>
<td>The name of the translation provider. May not be relevant for active jobs, which have not yet been submitted for translation.</td>
</tr>
<tr>
<td>Source</td>
<td>The locale of the source language. For an inactive job, you can click the link to view the source asset.</td>
</tr>
<tr>
<td>Column</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Target</td>
<td>The locale of the target language. For a job waiting for approval or for an inactive job, you can click the link to view the target asset.</td>
</tr>
<tr>
<td>Updated</td>
<td>The date the job was last updated, in the following format: YYYY-MM-DD.</td>
</tr>
<tr>
<td>Status</td>
<td>The status of assets in this job. For a list and description of asset statuses, see &quot;Translation Statuses&quot; on page 44.</td>
</tr>
</tbody>
</table>

3. Optional. To view more information about the job, including the list of assets in the job, click the link in the Job Name column. The Job Details page opens, as described in "Modifying a Job before Sending It Out for Translation" on page 36.

4. Optional. To approve translated jobs, select the corresponding check boxes in the Waiting for approval section, and click Approve Selected. The status of the selected jobs changes to Completed (translation approved).
7 Post-Translation Tasks

After assets return from translation, you can complete the following tasks:

- **"Approving Translated Assets" on page 54.**
  
  This task is required to change the status of the job to Completed (translation approved), and the status of the translated assets to Completed.

- **"Archiving Jobs" on page 56.**
  
  This task is optional, but it is recommended. Typically, you archive a completed job so that it will not be displayed anymore in the Inactive Jobs section of the Translation Jobs page. You can archive jobs both from the Contributor interface and the Clay Tablet Dashboard interface.

  **Note:** You cannot delete a completed job.

- **"Viewing Translated Assets" on page 58.**
  
  This task is optional. You can see a list of all the translated versions of this asset.

7.1 Approving Translated Assets

After a job returns from translation, it has the following status: Reviewing Translation. The translated assets within that job have the following status: REVIEW_TRANSLATION.

You must approve the translations before they return to OWCS, so that they will be ready for publishing to a website.

**Note:** Approving translated assets is not related to the CT: Approve Translation step in the CT: Approval for Content workflow process.

You can approve translated assets from either the Contributor interface or the Clay Tablet Dashboard interface:

- In the Contributor interface, you can click links to see the source and target versions.
- In the Clay Tablet Dashboard interface, you cannot see the source and target versions.

To approve translated assets:

1. Do one of the following:
   - In the Contributor interface, select **Translation > Job Status** from the menu.
   - In the Clay Tablet Dashboard interface, under **Management**, click **View All Jobs**.

   The Translation Jobs page opens. For a detailed description of this page, see "Monitoring All Translation Jobs" on page 45.

2. To view a list of assets in the translated job, click the link in the **Name** column for the job.

   The Job Details page opens. This page displays differently, depending on whether you open it from the Contributor interface or from the Clay Tablet Dashboard interface.
7 Post-Translation Tasks

7.1 Approving Translated Assets

**Important:** If you open this page from the Clay Tablet Dashboard interface, then there are no links in the Source Locale or the Target Locale column.

3. Optional. Review the translated asset. Available only if you are viewing this page from the Contributor interface.
   a. In the Job Details page, click the corresponding link in the Target Locale column in the asset list at the bottom of the page.
      
      The translated asset opens in a new tab.
   b. Review the translation.
   c. When you are done, click the Translation Jobs tab to return to the Job Details page.

4. Click the link for the job, to reopen the Job Details page.

5. In the asset list at the bottom of the page, select the check boxes for the assets you want to approve.

6. Click Approve Selected.

   A message box opens, confirming your approval.
7. Click **OK** to proceed.

   The status of each approved asset changes to **COMPLETED**.

8. After you approve all assets in a job, click the Refresh icon at the top of the page.

   The job's status changes to **Completed (translation approved)**.

### 7.2 Archiving Jobs

You archive a translation job so that it will no longer be displayed in the Connector interfaces, specifically, the Clay Tablet Dashboard interface, and the Contributor interface.

Typically, you archive a translation job after all its assets have been translated and approved, when it is *inactive*, which means it has either the **Completed (translation approved)** or **Completed (copied back)** status. However, in the Clay Tablet Dashboard interface, you can also archive a job when it has other statuses.

You can archive jobs as follows:

- In the Contributor interface, you can archive individual inactive jobs by clicking the **Archive Job** button in the **Job Details** page.
This button is displayed only if the job status is Completed (translation approved), and if the status of all the assets in the job is Completed, or if the job status is Completed (copied back).

- In the Clay Tablet Dashboard interface:
  - You can archive multiple inactive jobs from the Inactive Jobs section of the Translation Jobs page.

For a detailed description of this page, see "Monitoring All Translation Jobs" on page 45.

- You can archive individual active or inactive jobs with the In translation, Reviewing translation, or Completed status, by clicking the Archive Job button in the Job Details page.
Note: The Archive Jobs button is not displayed when a job has the Created status. However, you can delete a job with this status by clicking the Delete Job button.

Note: You can unarchive an archived job by clicking the Unarchive Job button when viewing the job in the Job Details page.

Warning: Archiving active jobs is not recommended. If you archive an active job, it will no longer be displayed in the Active Jobs list. Archiving a job also archives the assets in that job: If you archive content while it is being translated, then the Connector will not return the completed translation to you.

The following table summarizes job statuses and corresponding job activity and archiving information:

<table>
<thead>
<tr>
<th>Job Status</th>
<th>Active/Inactive Jobs</th>
<th>Archiving Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Created</td>
<td>active</td>
<td>cannot be archived</td>
</tr>
<tr>
<td>Sending</td>
<td>active</td>
<td>can be archived only from the Clay Tablet Dashboard interface, individually, from the Job Details page</td>
</tr>
<tr>
<td>Sent to CT Platform</td>
<td>active</td>
<td></td>
</tr>
<tr>
<td>In translation</td>
<td>active</td>
<td></td>
</tr>
<tr>
<td>Reviewing Translation</td>
<td>active</td>
<td></td>
</tr>
<tr>
<td>Completed (copied back)</td>
<td>inactive</td>
<td>can be archived in any of the following ways:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- from the Clay Tablet Dashboard interface, from the Translation Jobs page</td>
</tr>
<tr>
<td>Completed (translation approved)</td>
<td>inactive</td>
<td>- from the Clay Tablet Dashboard interface, individually, from the Job Details page</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- from the Contributor interface, individually, from the Job Details page</td>
</tr>
<tr>
<td><strong>Note:</strong> The job has this status only when all its assets have COMPLETED status.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 7.3 Viewing Translated Assets

When an asset is open in OWCS, you can view its translated assets. This means you can see a list of all the translated versions of this asset.

To view the translations of an asset:

1. In the Site Tree or the Content Tree, double-click an asset to open it.

2. Select Translation > View Translations from the menu.

The Translation for page opens.
It displays the following information about all the translated versions of this asset:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The type of asset.</td>
</tr>
<tr>
<td>ID</td>
<td>OWCS’s unique identifier for the asset.</td>
</tr>
<tr>
<td>Locale</td>
<td>The locale of this translation of the asset.</td>
</tr>
<tr>
<td>Asset Name</td>
<td>The name of the asset, which was specified when the asset was created.</td>
</tr>
</tbody>
</table>

3. Optional. In the **Asset Name** column, you can click the link to open the **Translation Status** page for this asset, where you can view the status of the asset in all the relevant locales. For details, see "Checking an Asset's Translation Status" on page 51.
8 Using Workflow to Manage the Translation Process

Most websites are produced by a team of people in which different individuals assemble content, edit and review it, and decide what goes where and when to update the pages. Work flows from one person to the next in a predictable way, and that process in OWCS is called workflow. In OWCS, assets can be assigned to a workflow. This transfers permissions for these assets to a particular user, so that these assets are displayed in the user’s Assignments list on the Home tab of the dashboard of the Contributor interface.

If properly configured, you can use the CT: Approval for Content workflow with the Connector to manage your translations. To use the workflow with the Connector, you put assets in the workflow in the Contributor interface. Using the workflow with the Connector has the following advantages:

- When assets come back from translation, they are in a new workflow state. Your company may have configured OWCS to send out email notifications when assets change state. This is helpful to the people who review translated assets before publication.
- You may receive email notifications when an asset is translated or assigned to you.
- Your company may have extended and integrated the final step of the CT: Approval for Content workflow with other workflows. For example, this workflow may be configured so that the asset is assigned to an additional person for review and approval before publication, for example, a legal review.
- You may be able to assign due dates to assets.
- You may be able to delegate your assignments to other people.

What is the Connector's support for workflow?

When the CT: Approval for Content workflow process is properly configured in OWCS, you can select it when you collect assets for translation.

If you select this workflow:

- When you send out assets for translation, you specify the workflow process, and the target OWCS asset is inserted into the workflow in the CT: Pending Translation state.
- When the translated asset returns from translation, the OWCS asset automatically advances to the CT: Translated, Pending Approval state.
- When you resend the asset for translation, it reverts to the CT: Pending Translation state.

The CT: Approval for Content workflow has the following states and steps:

<table>
<thead>
<tr>
<th>Workflow State</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CT: Pending Translation</td>
<td>An asset is in this state when you add it to the workflow process, before it is translated.</td>
</tr>
<tr>
<td>CT: Translated, Pending Approval</td>
<td>An asset is in this state after it is translated, and before the translation is approved.</td>
</tr>
</tbody>
</table>
The order in which the assets move between states is defined in the workflow process by the following four steps. A step is the action of moving the asset from one state to the next.

<table>
<thead>
<tr>
<th>Workflow Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CT: Send for Translation</td>
<td>This step moves assets into the workflow in the CT: Pending Translation state, where they have not been translated.</td>
</tr>
<tr>
<td>CT: Send for Approval</td>
<td>This step moves assets from the CT: Pending Translation state, where they have not been translated, into the CT: Translated, Pending Approval state, where the assets have been translated, but they have not yet been reviewed.</td>
</tr>
<tr>
<td>CT: Approve Translation</td>
<td>This step moves assets from the CT: Translated, Pending Approval state, where they have not been translated but not yet reviewed, out of the workflow. If your company has an existing workflow, instead of moving assets out of the translation workflow, you can add custom steps to include that workflow. For example, you can add another step to the workflow to require legal approval of content. <strong>Note:</strong> This workflow step is not related to approving translations in the Contributor interface.</td>
</tr>
<tr>
<td>CT: Resend for Translation</td>
<td>This step sends assets that have already been translated back to translation. This step is useful if the translation is not satisfactory or if many changes are required.</td>
</tr>
</tbody>
</table>

In order for the workflow process to work as described above, it must be configured. For detailed configuration instructions, refer to the *Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration Guide*.

**How to use workflow with the Connector**

When the workflow is integrated with the Connector, you perform the following major tasks to manage your translations:

**Note:** The instructions below are correct for either a single asset or multiple assets.

1. When you collect assets for translation, you assign them to the "Assigning Collected Assets to a Translation Workflow" on page 62.

2. Optional. You can view the workflow status of an asset anytime after you add the asset to the workflow.
   - For information on viewing the status of a single asset, see page 62.
   - For information on viewing the status of multiple assets, see page 63.

4. You send out the job containing the assets for translation, as described in "Sending Out Jobs for Translation" on page 42.

5. After the assets return from translation, you can review them and move them out of the workflow, or to a custom state of the workflow that your company has configured. For details, see "Reviewing Translated Content" on page 64.

### 8.1 Assigning Collected Assets to a Translation Workflow

When you collect assets for translation, you can assign them to the CT: Approval for Content workflow process.

To add one or more collected assets to the translation workflow process:

1. Collect one or more assets for translation, as described in "Collecting One Asset for Translation" on page 15 or "Collecting Multiple Assets for Translation" on page 21.

2. In the **Select Target Workflow** dropdown list, select the **CT: Approval for Content** workflow.

   ![Select Target Workflow](image)

   This assigns the assets to the workflow.

3. Continue collecting the assets to send for translation, as described in the relevant sections of this guide.

   **Important:** After you assign assets to the **CT: Approval for Content** workflow, you must still add them to a new or an existing job, and then send them out for translation from the Job Details page. As an intermediate step, you can add assets to the Translation Queue before adding them to a job.

### 8.2 Viewing the Workflow Status of One Asset

After you assign an asset to the **CT: Approval for Content** workflow, you can select **View > Status** to see its workflow status.

**Note:** This is standard OWCS functionality.

To do this:
1. Ensure that the asset is open in OWCS in the active tab.

2. Select **View > Status** from the menu.

   The **Content** page for the asset opens.

3. Scroll down to the **Workflow process** field.

   ![Workflow process field](image)

   This field displays both the name of the workflow process, **CT: Approval for Content**, and the workflow state, **CT: Pending Translation**.

   The workflow state in the screen capture above indicates that the asset has not yet been sent out for translation.

---

### 8.3 Viewing the Workflow Status of Multiple Assets

After you assign assets to the **CT: Approval for Content** workflow, they are displayed in your **Assignments** list on the **Home** tab of the dashboard of the Contributor interface.

**Note:** This is standard OWCS functionality.

The following screen capture displays assets that were sent to translation, so the **Action to Take** is to wait for the assets to return from translation.

![Assignments list](image)
8.4 Reviewing Translated Content

When an asset returns from translation and is ready for you to review, it is displayed in your Assignments list on the Home tab of the dashboard of the Contributor interface:

![Assignments list screenshot]

Note: Depending on the CT: Approval for Content workflow is configured in your company, you may also receive an email notification.

To review translated content:

1. In your Assignments list on the Home tab of the dashboard of the Contributor interface, click the Review translation link.

The Content page for the asset opens.
The **Workflow process** field displays both the name of the workflow process, CT: Approval for Content, and the workflow state, CT: Translated, Pending Approval.

2. To proceed to the next step and move the asset through the workflow, in the **Workflow commands** dropdown list, select Finish My Assignment.

**Note:** For descriptions of the other options, refer to the appropriate version of the OWCS documentation at [http://www.oracle.com/technetwork/middleware/webcenter/sites/documentation/index.html](http://www.oracle.com/technetwork/middleware/webcenter/sites/documentation/index.html).

The **Finish My Assignment for Content** page opens.
3. Do one of the following:

- If you approve the translation, click **CT: Approve Translation** → (null state) to end the workflow.

  **Note:** If your workflow has been configured for additional workflow steps before publishing, for example, a legal review, then after the arrow, then the name of the custom step is displayed after the arrow, instead of (null state).

- If you do not approve the translation, and you want to send it back to translation, click **CT: Resend for Translation** → **CT: Pending Translation**. This changes the state of the asset back to **CT: Pending Translation**.
4. Optional. In the **Action Taken** field, enter a short description of the work you completed on the asset.

5. Optional. In the **Action to Take** field, enter brief instructions for the person receiving the assignment.

6. Click **Finish My Assignment**.
9 Administrative Tasks

This section lists and describes the administrative tasks you can perform in the Clay Tablet Dashboard interface. Some of these tasks are very similar to tasks performed in the Contributor interface. In those cases, there are links to the relevant sections elsewhere in the guide, where there are descriptions of the differences between both interfaces.

You can perform the following administrative tasks in the Clay Tablet Dashboard interface:

- viewing the status of translation jobs and assets
  Under Management, click View All Jobs to open the Translation Jobs page. For a detailed description of this page and the related Job Details page, see "Monitoring All Translation Jobs" on page 45 and "Monitoring Assets in a Single Job" on page 48.

- viewing the assets in the Translation Queue and adding them to jobs
  Under Management, click View All Queues to open the Translation Queue. For a detailed description of the queue, see "Adding Assets in the Translation Queue to Jobs" on page 30.

- approving translations
  Under Management, click View All Jobs to open the Translation Jobs page. Then click a job in the Name column to open the Job Details page. For detailed instructions, see "Approving Translated Assets" on page 54.

- checking the Clay Tablet Platform for messages
  Under Utilities, click Check Messages Now to open the Check Messages page. For a detailed description, see "Checking the Platform for Messages" on page 69.

- updating the Clay Tablet Platform with translated files, if the translation provider could not submit them back to you via the Platform and the Connector
  Under Utilities, click Submit Translated Files to open the Submit Translated Files page. For a detailed description, see "Checking the Platform for Messages" on page 69.

**Important:** The following functionality that is available to global administrators (users assigned to the CTAdmin role) in the Clay Tablet Dashboard interface is described in the *Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration Guide*:

- Configuration
  - System Configuration
  - Site Configuration
  - Translation Providers
  - PO Numbers Configuration (also available to site administrators, who are users assigned to the CTSiteAdmin role)
9.1 Checking the Platform for Messages

You can check the Clay Tablet Platform for messages about outstanding translation jobs. To use this utility:

1. In the Clay Tablet Dashboard interface, under Utilities, click Check Messages Now.

The Checked Messages page opens.

This page displays information about messages, files, jobs, and assets currently processed by the Platform. If any of these are stuck on the Platform, they will be displayed on this page.

For details, view the sites.log file.

2. To update the results, click Check again at the bottom of the page.
9.2 Submitting Translated Files

Suppose that the translation provider cannot return the translated files to you via the Clay Tablet Platform and the Connector. For example, this might happen if there is a connectivity issue between the provider and the Platform. In this scenario, the translation provider can send you the translated files outside of OWCS, for example by email.

Even though you have received the translated files, it is still important to add these files to the Clay Tablet system, so that the system will be up to date with the translated files. This means that in the future, you will be able to use all the Clay Tablet features effectively, such as requesting translation updates, instead of translating all the previously translated files. This substantially reduces translation time, cost, and effort.

In this scenario, you use the **Submit Translated Files** utility to add translated files to the Clay Tablet system. To use this utility:

1. In the Clay Tablet Dashboard interface, under **Utilities**, click **Submit Translated Files**.

   The **Submit Translated Files** page opens.

![Submit Translated Files](image)

2. Click **Browse**, and in the browser dialog box that opens, browse to the translated file. This file is either:
   - a single translated file in XML format
   - a single zipped file that contains multiple translated files in XML format

3. Select the file to upload, and close the dialog box. For example, in Firefox, click **Open**.

4. Click **Submit**.

   The message **Uploading...** is displayed.
Index

A
assets
|   adding collected to workflow 62 |
|   adding to translation jobs 30   |
|   in the Translation Queue 30    |
|   approving translated 54        |
|   using workflow 64               |
|   checking translation status 51  |
|   collecting for translation 15  |
|   multiple assets 21             |
|   one asset 15                   |
|   overview 10                    |
collecting multiple for translation 21
collecting one for translation 15
copying between jobs 40
filtering in a list 27
managing collected, overview 10
monitoring 48
statuses 44
viewing translated 58
Assignments list, viewing workflow assignments 62

C
Checked Messages page 69
Clay Tablet Connector for Oracle WebCenter Sites Installation and Configuration Guide 8
Clay Tablet Dashboard interface 11
Clay Tablet Platform, checking for messages 69
Clay Tablet Support 8
Contributor interface 11
CT: Approve Translation workflow step 61
CT: Pending Translation workflow state 60
CT: Resend for Translation workflow step 61
CT: Send for Approval workflow step 61
CT: Send for Translation workflow step 61
CT: Translated, Pending Approval workflow state 60

D
documentation conventions 8

E
error handling 70

F
feature overview 9
Filter section of page 27

G
guide 6

I
introduction 5

J
Job Details page
|   archiving jobs 56           |
|   collecting multiple assets for translation 24 |
|   collecting one asset for translation 17        |
|   copying assets between jobs 40                   |
|   Filter section 27                               |
|   from the Translation Queue 33                   |
|   modifying a job 36                              |
|   monitoring a job 48                             |
|   jobs                                           |
|   archiving 56                                   |
|   copying assets between 40                       |
|   modifying 36                                    |
|   monitoring all 45                               |
|   monitoring one 48                                |
sending out for translation 42
statuses 44
O
Optimize Translation feature 10
overview 11

P
post-translation features, overview 54

Q
Queued Assets for Translation page
Filter section 27

S
Select Target Workflow dropdown list 62
Send Modified Fields Only check box 10
statuses
translation 44
viewing workflow for multiple assets 63
viewing workflow for one asset 62
Submit Translated Files page 70
support 8

T
Translate Branches of Page page 21
Translate Children of Asset page 21
Translate Multiple Assets of Type page 22
Translate page 15
translated files, adding to Clay Tablet 70
translation-management overview 13
Translation For page 58
Translation Jobs page 45
archiving jobs 56
translation lifecycle 5
and the Connector 5
Translation menu 11
translation provider, selecting 11
Translation Queue 30
Filter section 27
Translation Status page 51
translation statuses 44
monitoring 44
translations
approving 54
approving using workflow 64
reviewing translated content with workflow 64
troubleshooting 69

W
workflow
assigning collected assets 62
overview 60
reviewing translated content 64
viewing the status of multiple assets 63
viewing the status of one asset 62